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2. Important User Information

Thank you for using EKO Products

Make sure to read this instruction manual thoroughly and to understand the contents before starting to operate the
instrument. Keep this manual at safe and handy place for whenever it is needed.

For any questions, please contact us at one of the EKO offices given below:

2-1. Contact Information

EKO INSTRUMENTS co., LTD.

Asia, Oceania Region

EKO INSTRUMENTS Co., Ltd.

1-21-8 Hatagaya, Shibuya-ku Tel:  +81 (3) 3469-6711
Tokyo, 151-0072 Japan Fax: +81 (3) 3469-6719

www.eko.co.jp
info@eko.co.jp

Europe, Middle East, Africa, South America Region

EKO INSTRUMENTS Europe B.V.

Lulofsstraat 55, Unit 32, Tel:  +31 (0)70 3050117
2521 AL, Den Haag, The Netherlands Fax: +31 (0)70 3840607

www.eko-eu.com
info@eko-eu.com

North America Region

EKO INSTRUMENTS USA Inc.
95 South Market Street, Suite 300 Tel: +1408-977-7751
San Jose, CA 95113 USA Fax: +1408-977-7741

www.eko-usa.com
info@eko-usa.com

2-2. Warranty and Liability

For warranty terms and conditions, contact EKO or your distributor for further details.
EKO guarantees that the product delivered to customer has been verified, checked and tested to ensure that
the product meets the appropriate specifications. The product warranty is valid only if the product has been

installed and used according to the directives provided in this instruction manual.

In case of any manufacturing defect, the product will be repaired or replaced under warranty. However, the
warranty does not apply if:
»  Any modification or repair was done by any person or organization other than EKO service
personnel.
»  The damage or defect is caused by not respecting the instructions of use as given on the product

brochure or the instruction manual.
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2-3. About Instruction Manual

Copy Rights Reserved by EKO INSTRUMENTS CO., LTD. Making copies of whole or parts of this
document without permission from EKO is prohibited.

This manual was issued: 2016/09/27

Version Number: 1

2-4. Environment

1. WEEE Directive 2002/96/EC
(Waste Electrical and Electronic Equipment)
This product is not subjected to WEEE Directive 2002/96/EC however it should not be mixed with general

household waste. For proper treatment, recovery and recycling, please take this product(s) to designated
collection points.

Disposing of this product correctly will help save valuable resources and prevent any potential negative
effects on human health and the environment, which could otherwise arise from inappropriate waste
handling.

2. RoHS Directive 2002/95/EC

EKO Instruments has completed a comprehensive evaluation of its product range to ensure compliance with
RoHS Directive 2002/95/EC regarding maximum concentration values for substances. As a result all products
are manufactured using raw materials that do not contain any of the restricted substances referred to in the
RoHS Directive 2002/95/EC at concentration levels in excess of those permitted under the RoHS Directive
2002/95/EC, or up to levels allowed in excess of these concentrations by the Annex to the RoHS Directive
2002/95/EC.
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2-5. CE Declaration

— Ko IMPORTANT USER INFORMATION

Ce

DECLARATION OF CONFORMITY

We: EKO INSTRUMENTS CO., LTD
1-21-8 Hatagaya Shibuya-ku,
Tokyo 151-0072 JAPAN

Declare under our sole responsibility that the product:

Product Name:  Spectroradiometer
Model No.: MS-700N

To which this declaration relates is in conformity with the following harmonized
standards of other normative documents:

Harmonized standards:

EN 61326-1:2006 Class B (Emission)
EN61000-3-2+A1+A2:2009
EN61000-3-3:2008

EN 61326-1:2006 Table 1 (Immunity)
EN61000-4-2 EN61000-4-3
EN61000-4-4  EN61000-4-5
EN61000-4-6  EN61000-4-11

EN61000-4-8:2010

Following the provisions of the directive:
EMC-directive: 89/336/EEC
Amendment to the above directive: 93/68/EEC

Date: Dec. 21, 2015

Position of Authorized Signatory: Deputy General Manager of Quality Assurance Dept.
Name of Authorized Signatory: Shuji Yoshida

Signature of Authorized Signatory: "()A/?(’ /7] 5‘””/“\ f/’ﬂi

v
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3. Safety Information

EKO Products are designed and manufactured with consideration for safety; however, please make

sure to read and understand this instruction manual thoroughly to be able to operate the instrument

safely in the correct manner.

é WARNING Attention to user; pay attention to the instructions given on the
CAUTION instruction manual with this sign.

WARNING

1. Setup

> Installation base or mast should have enough load capacity to set the Grating Spectroradiometers
MS-700N. Fix MS-700N securely to the base or mast with bolts and nuts; otherwise, the
instrument may drop due to gale or earthquake and may invite unexpected accidents.
Do not use these instruments in different use other than its original purpose.
Do not disassemble, modify or touch inside these instruments.
Do not place these instruments in places where humidity and/or dusts exist, extreme difference in
temperature of over specification range, near object which emits strong magnetic energy or
electric wave. These conditions may cause damages to the instrument.

>  Make sure to install these instruments where maintenance can be performed safely.

CAUTION

1. Power Supply
» Do not touch the terminals and power plug with wet hands. This will lead to electric shocks and
leakages.
»  Check the voltage and provided power type (AC, DC) to make sure they are suitable for the
instrument specification before turning the power on.
>  Use only the attached cables. Using any other cables may lead to electric shocks or leakages.
EKO Instruments will not be held responsible in case of accidents or measurement accuracy by

using cables other than specified by EKO.

2. Handling
»  Hold the bottom part of the instrument firmly when carrying this instrument.
»  Holding the cover, glass dome or any other part of this instrument can lead to damage or dropping
instrument.

»  Be careful with handling the glass dome.
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4. Introduction

The Grating Spectroradiometer MS-700N is designed to provide the most accurate solar spectral data outdoors.
The MS-700N is a unique all weather concept instrument with temperature controlled spectrometer, which provides
extensive spectral range from 350nm to 1050nm (UV / Visible / NIR). MS-700N is accurately calibrated with

traceability to the International Standards and issued with a calibration uncertainty budget.

Temperature changes of the detector inside the spectrometer have a strong effect on the measurement
uncertainity. Therefore the sensor unit inside the MS-700N sensor is accurately controlled at a stable temperature
in order to provide the best performance in a wide operating temperature range. The rugged optical design of the
diffusor and input optics make the MS concept superior to any fiber optic spectroradiometer which will be
susceptible to mechnical vibration and handling. The MS-700N is designed for permanent installation, but is

perfectly suited as a traveling reference.

MS-700N has a separate power supply unit and can be controlled through RS232 / 422 by a PC or data logger.
The PC software provides different functions for operating, data management and visualisation. Measuring
spectral irradiance is a must to understand the effect of the non-uniform energy distribution of the sun. Since the
solar spectrum varies as a function of air-mass and composition of the atmosphere, the MS-700N reveals those
details. While thermopile pyrheliometer and pyranometer are most suitable to quantify the total DNI or global
radiation (W/m?), spectroradiometers give detail about the energy distribution (W/m?nm), which is most important

for PV or CPV cell research and performance analysis.
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4-1. Main Features

1. All-Weather

MS-700N solar spectroradiometer is designed to be used as the spectral measurement standard in any

outdoors environment around the world.

2. Durability

The dome, diffuser, grating and photodiode array are embedded in MS-700N to maximize the performance

and guarantee durability.

3. Adaptive Measurement
The detector exposure time will be automatically adapted between 10ms and 5sec to optimize the signal to

noise ratio, which makes the MS-700N suitable to measure during fluctuating solar irradiance conditions.
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4-2. Package Contents

Check the package contents first; if any missing item or damage is noticed, please contact EKO immediately.

Table 4-1. Package Contents

Standard Items Qty. Remarks
MS-700N Sensor 1 unit
Fixing screws 1 set Bolts: M8 x 75, Washers, Nuts (x2 each)
Power supply / control unit 1 unit
Sensor cable 1 10m (Standard length)
AC power cable 1 2m
RS-232C cable 1 1.5m
Software CD-ROM 1 SPDac700N_1xxx.exe and SPDisp700N_1xxx.exe software,
Instruction Manual in PDF
Instruction manual 1

EKO INSTRUMENTS CO., LTD Grating Spectroradiometer MS-700N Instruction Manual Ver.1
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5. Getting Started

5-1. Parts Name and Descriptions

Each part name and its main functions are described below.
Table 5-1 and Figure 5-1 describe the sensor parts, and Table 5-2 and Figure 5-2 describe the power supply
parts.

1. Sensor Part

Table 5-1. Names and functions of Sensor Part

INET L Function

Used for leveling the sensor horizontally, adjust the two leveling screws to place a

1 | Spirit Level i )
bubble in the center of the circle.
2 | Fixing Holes Used for fixing the instrument in leveled position. Fix the sensor for safety.
3 | Diffuser The diffuser diffuses the incident light from sky hemisphere, and it compensates the
iffu

intensity of the incident light to comply with cosine characteristics.

Dome protects the sensor inside from soiling and effects from rain and wind, and it
enhances the cosine characteristics which incident from the sky hemisphere..
Sensor/Power Supply | Connect Sensor/Power Supply Cable. Transmit power from power supply to
Cable Connector sensor. Connector part is waterproofed.

Used for keeping inside the sensor dry. It is necessary to replace it periodically
when the desiccant color change.

4 | Quartz Dome

6 | Drying Cartridge

7 | Cover Prevents from sensor’s internal temperature increasing by solar radiation.

) To set the sensor in horizontal position, adjust 2 screws as monitoring the spirit
8 | Leveling Screws

level.

1. Spirit Level

4. Quartz Dome 3. Diffuser

2. Fixing Hole

5. Sensor/Power Supply
Cable Connector

6. Drying Cartridge

8. Leveling Screws

Figure 5-1. Parts Name and Function (Sensor Parts)

EKO INSTRUMENTS CO., LTD Grating Spectroradiometer MS-700N Instruction Manual Ver.1 Pg. 10



2. Power Supply

Table 5-2. Names and functions of power supply

| Name ‘ Function
1 | Power switch When the power switch is pushed to right side, power is ON, to left side power is
OFF.
2 | Connector Strip Block
Terminal block Wire Color W#itre
1 TXD+ (RS-422) Brown 1
2 TXD- (RS-422) Red 2
3 RXD+ (RS-422) Orange 3
4 RXD- (RS-422) Yellow 4
5 Digital GROUND Green 5
6 Supply power +12V Gray/Blue 6
7 Supply power ground Whl(t;er/e\;er:low 7 (DC GND)
8 Peltier Control +12V Black 8
9 Peltier Control Ground Pink 9 (DC GND)
10 EARTH Black 10
3 | RS-232C Connector Connect RS-232C cable to PC.
4 | Fuse Holder Set 2A fuse.
5 | AC Power Connector | Voltage range is AC100 to 240V, frequency is 50 / 60Hz.

5. AC Power Supply Connector 4. Fuse Holder
1. Power Switch 3. RS-232C Connector

INNT

11:45 7 8 3 10

2. Connector Strip

Figure 5-2. Parts Name and Function (Power Supply Parts)

A CAUTION: Before switching the power on, make sure that the grid supply voltage

corresponds to the rated voltage as specified.
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5-2. Setup Location

1. Location

In order to obtain representative measurements from spectroradiometers, several criteria with respect to

setup and mounting of the instruments have to be considered*:

The ideal mounting position for the spectroradiometer is a location which has a full hemispheric field-of-view
without any obstructions (such as buildings, trees, and mountain). In practice, it might be difficult to find such
locations. Therefore, some practical recommendations on how to minimize undesired effects of reflecting or
obstructing surfaces are given next:
e Select a mounting position which it is free from obstructions at 5° above horizon.
e The setup location should be easily accessible for periodic maintenance (quartz dome cleaning,
desiccant replacement, etc.).
e Avoid surrounding towers, poles, walls or billboards with bright colors that can reflect solar radiation
onto the spectroradiometer.

2. Installing at Horizontal or tilted Positions

(1) Prepare Installation Base
Check the installation base where the MS-700N sensors have to be mounted and make sure it has two

fixing holes with the appropriate pitch. The pitch sizes of the fixing holes are as follows (in mm):

Table 5-3. Fixing Hole Pitch and Bolt Size

MS-700N Sensor

Fixing Hole Pitch

Fixing Bolt Size

p240

2-10¢p Fixing Holes

180

Figure 5-3. Dimensions
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(2) Setup the MS-700N Sensors
Setup the sensors with the signal cable connector facing the nearest Earth’s pole.
In the Northern hemisphere, the connector should be orientated North, in the Southern hemisphere,

the connector should be orientated South.

(3) Leveling
Adjust the sensors in a horizontal position by using the 2 leveling screws and observing the air
bubble in the spirit level while manipulating the leveling screws. The instrument is leveled
horizontally if the air bubble is in the center ring. Once the instrument is leveled properly, fix the
instrument with mounting bolts.
In case the sensor is mounted on a tilted plane, preferably the sensor is mounted on the leveling

screws to thermally isolate the sensors form the mounting platform.

If the sensor is not leveled properly, the readings are affected by cosine and azimuth errors.

Periodically check the spirit level and adjust its position if necessary.

(4) Cover

Place the Cover on the instrument and fasten with 3 screws (M3).

v

Figure 5-4. Attaching Cover

(5) Connect Sensor Cable
Connect the sensor cable connector to the sensors and the Y-terminals to the terminal block of the
power supply according to the table below.
Make sure the sensor connector part is securely connected so that moisture will not enter the
connector.  Also fasten the cable with such as band strip so that it will not be blown by wind
If the sensor is setup on Sun Tracker, make sure to have sufficient length of cable for rotation
movement.
Use Phillips type screw driver to connect the cable to lug terminals on the power supply, make sure

the cable numbers and the terminal numbers match.

The power supply can’'t be used in an unprotected outdoors environment, as it can only be

used in a dry environment.
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Table 5-4. Terminal block layout and Wire colors

Terminal block

Wire Color ‘ WIGCE::

1 TXD+ (RS-422) Brown 1
2 | TXD- (RS-422) Red 2
3 RXD+ (RS-422) Orange 3
4 RXD- (RS-422) Yellow 4
5 Digital GROUND Green 5
6 Supply Power +12V Gray/Blue 6
7 Supply Power ground Whl(t;‘er/eYeer:Iow 7
8 Supply Power +12V Black 8
9 Supply Power Ground Pink 9
10 EARTH Black 10

(6) Connect Power Supply

(DC GND)

(DC GND)

Connect the one end of power cable to AC power supply connector at the rear of power supply. Then

connect the other end of power cable to the socket properly. Make sure that provided power is
AC100-240V, 50/60Hz, 50VA.

(7) RS-232C

Connect the PC COM port and the RS-232C connector at the back of the power supply with

RS-232C cable.

CROTOTOTOTOTOTOTOIONO K
e RS R R R R RS

When connecting, insert the connector which has ferrite core to the power supply.

Figure 5-5. RS-232C Connection
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6. Software

This software is exclusively used for measuring and processing the data acquired by MS-700N. It is used to

measure and analyze data.

MS-700N
[WSDac700N_1xxx.exe]
RS422 RS232C | Measurement Software
Power S [WSDisp700N_1xxx.exe]
Supply Data Analysis Software

4 4
J

WSD file CSV file

Figure 6-1. Outline of Software

WSDac700N software is the control and measurement software that includes periodic measurement of the
MS-700N via RS-232C communication, and creates a data file (WSD file) described in section 6-4.

WSDisp700N software is the data managing software. WSDisp700N loads WSD data file that is created by

WSDac700N. It has functions of graphing, data format converting and data calculations.

WSDac700N and WSDisp700N software selects Japanese/English displaying language automatically by checking

language settings in Windows.

Notes: This software is designed to manage with one unit of MS-700N.
1. When using multiple MS-700N spectroradiometers with one PC
The sensitivity of MS-700N which is connected and turned ON is set when the software is started. When
replacing the MS-700N with another MS-700N, turn on MS-700N and re-start the software each time.
Creating individual folder for each spectroradiometer is recommended.
2. PCtime settings

Set the time-zone and local time of the PC based on the measurement site.
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6-1. Installation and Uninstallation

1. Installation

NOTE: Make sure to install the software on a PC which has administrative and/or installation authority.

1) Power ON the PC and insert the installation disk to the CD disk drive while the Windows desktop screen
is displayed.

2) The install disk is included in the CD-ROM labeled as “Spectroradiometer MS-700N”. The separate
software for the measurement software and data analysis are included in this CD-ROM.
To install measurement software (WSDac700N_1xxx.exe and WSDisp700N_1xxx.exe), click
[MS-700N_Software_Verl.x.x.x_Installer] [ [English] [ [Setup.exe] and start the installer.

3) Installation Wizard window appears. To go to the next step, click [Next].

15! MS-700N Software Verl 0.0.0 English - InstallShield Wizard [=23a)

Welcome to the InstallShield Wizard for
MS-700N Software Ver1.0.0.0 English

The InstallShield(R) Wizard will allow you to modify, repair, or
remove M3-700N Software Ver 1.0.0.0 English. To continue,
dick Next.

< Badk [ Next = ] [ Cancel ]

Figure 6-2. Installation Wizard Startup Window

4) “License Agreement” window appears; select “I accept the terms in the license agreement” then click

[Next] button to go to the next step.
15 MS-T00M Software VerL.0.0.0 English - InstallShield Wizard

License Agreement
Flease read the following license agreement carefully,

Software License Agreement

| »

This agreement provides prerequisites for the software use mentioned below
between the User and FKO Instrutnents Co., Ltd, ("EEKO™).

The software includes the software attached to EKO products and the software
progratn ("Softweare") mentioned in this agreement. Do not install or use the
Software until you have read and accepted all of the license terms.

Article 1. Definitions

T Tha CaBrrmmarn smmmana mM A ;b mind dn st dad e e DT DR e Al i s i name
@) I accept the terms in the license agreement Prink

(7)1 do not accept the terms in the license agresment

Installshield

[ < Back ]E_ Mext = _] [ Cancel

Figure 6-3. License Agreement Window
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5) “Destination Folder” window appears. If the software will be installed in the “C:\EKO” folder, click [Next]
button to go to the next step. To change the destination folder, click [Change...] button and select the

appropriate folder.

15 MS-700N Software Verl 0.0.0 English - InstallShield Wizard (=23a)
Destination Folder
Click Mext to install to this folder, or dick Change to install to a different fold
Instal MS-700N Software Ver1.0.0.0 English to:
—/ cieoms
Instalshield
[ < Back ][ Next > ] [ Cancel

Figure 6-4. Destination Folder Window

NOTE: If the Operation System for the installing PC is either one of the Windows Vista, 7, or 8 and to
change the destination folder, UAC (User Account Control) function will be effective, and it will need
special attention. Installing and/or data uploading in the folder which OS is restricting the access
authority may generate problems. There are “C:\Program Files”, “C:\ProgramData”, “C:\Windows”,
and system drive route folder “C:\” for such folder with restrictions. Avoid these folders when

changing the destination folder.

6) “Ready to Install the Program” window appears. Confirm the destination folder and if okay, click

[Install] button to go to next step.

‘_EJ MS-T00M Software Ver L0.0.0 English - InstallShield Wizard

Ready to Install the Program

The wizard is ready ko begin installation,

If vou want to review or change any of vour installation settings, click Back, Click Cancel ta
it the wizard,

Current Setkings:

Setup Type:
Typical
Destination Folder:
CHEKOMS-700M,

User Information:
Mame:! eko
Compary:

Installshisld

I < Back |[ 'g:f'lnstall ][ Cancel l

Figure 6-5. Install Window
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7) After a while, the PC display goes dark and “User Account Control” dialog window appears. Click [Yes]

button to start the software installation.

@ User Account Control

Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  Ch\Users\Eko-Qt\AppData\Local\Downloaded
Installations\{6 CEE4FFF-3111-496D-9438-,.\M5-700N
Software Verl.0.0.0 English.msi

Publisher: Unknown
File origin: Hard drive on this computer
(%) Show details ves [ Mo

Change when these notifications appear

Figure 6-6. User Account Control Window

8) As the installation is completed, the following window appears. Click [Finish] button to close the

installation window.

1) MS-700N Software Ver 0.0.0 English - InstallShield Wizard

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed MS-700M
~ Software Ver1.0.0.0 English. Click Finish to exit the wizard.

< Back Cancel

Figure 6-7. Installation Complete Window

9) When the installation is completed, a shortcut icon as shown below will be created on the desktop, as
well as in the Start Menu, “All Programs” > “EKO” - “MS-700N Software Verl.x.x.x English” ->
“WSDac700N_1xxx.exe” or “WSDisp700N_1xxx.exe”.

Figure 6-8. “WSDac700N_1xxx.exe” and “WSDisp700N_1xxx.exe” Shortcut Icon
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2. Uninstallation

There are 2 ways to uninstall the software.

1) Uninstalling from the “Programs and Features”

Access by clicking “Control Panel” - “Program and Features”.

and right click; the popup menu will appear. Select “Uninstall”.

=3 HoR <=

@th’ﬂ v Control Panel » Programs » Programs and Features

- | +y | | Search Programs and

Control Panel Home
View installed updates

off

Uninstall or change a program

To uninstall a pregram, select it from the list and then click Uninstall, Change, or Repair.
'{g' Turn Windows features on or

og

Organize *  Uninstall  Change  Repair

Name Publisher Installed On
51 M5-T00M Software Verl.0.0.0 English EKO T KE
8P HC-121 Measurement Software Ver7411 English  EKO m KB
§ HC-121 Calibration Software Ver2.4.1.2 English EKO Ebange KB
B HC-120 Calibration Software Ver2.7.0.0 English EKO Repair KB

EKO Product version: 1.0.0.0 Support link: http://eko.co.jp

Help link: http://eko.co.jp Size: 300 KB

ol

= - @
Version
1.0.00
7411
3412
27.00 -

-

Following message appears; to uninstall, click [Yes] button.

“Programs and Features” list and confirms the software has been uninstalled.

Figure 6-9. Uninstalling from “Programs and Features”

-
r\ﬂ_;' User Account Control [z

o

U Do you want to allow the following program from an
/" unknown publisher to make changes to this computer?

Program name:  C:\Users\Eko-Qt\AppData\Local\Downloaded
Installations\{6 CEE4FFF-3111-4960-9438-...\M5-700MN
Software Verl.0.0.0 English.msi

Publisher: Unknown

File origin: Hard drive on this computer

) Show detsi

Change when these notifications appear

Figure 6-10. User Account Control Window

2) Uninstalling from Installation Disk

‘_'@ M5-700N Software Verl.0.0.0 English - InstallShield Wizard

Program Maintenance

Modify, repair, or remove the program.

_) Modify
@ Change which program features are installed. This option displays the

Custom Selection dialog in which you can change the way features are
installed.

) Repair

Repair installation errors in the program. This option fixes missing or
corrupt files, shortcuts, and registry entries.

@ Remove

@ Remove M3-700M Software Ver 1.0.0.0 English from your computer.
% |

InstallShield

[ < Back ][ MNext = ] [ Cancel

Figure 6-11. Uninstalling from CD-ROM

Select the program to be uninstalled

The software will disappear from the
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Just like when the software was installed, startup the software to be uninstalled from the CD-ROM.
Proceed according to the messages appear on the window. If the software is already installed, there
appear the options as “Modify”, “Repair” and “Remove”.

Select “Remove” from this window and click [Next] button.

Follow the messages on each step will result in uninstalling the software.
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6-2. Data File Format

The following data file formats are available for this software.

Table 6-1. File Format

| File format ‘ Binary/ASCI| ‘ Wavelength increment
a ESM file Binary Specified as spectroradiometers
Specified as spectroradiometers
CsV file ASCII ]
c 1nm interval

1. WSD File (Binary Data)

WSD format data file is composed as binary data. Only the spectral radiation data of the wavelength interval

according to spectroradiometers specifications is saved in WSD file.

2. CSV File (ASCII)

CSV file is composed as ASCII format data. The spectral radiation data of wavelength interval according to
the spectroradiometers specification can be saved in CSV file, as well as the as well as the spectral radiation
data which wavelength interval sampled at 1nm. The CSV file data is easily converted to other formats,

including Microsoft Excel.

[Measured Value of CSV Data File and Calculated Value of CSV Data File]
This software can save the CSV data file of measured value which radiation is output for each wavelength, as

well as the CSV data file of calculated value which output the calculation result.

[Measured Value of CSV Data File]
Radiation data of each wavelength is saved. This file contains the instrument data which is selected ahead

of time. See “CSV Format Data” in section “7-2 Before Starting Measurements”
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Table 6-2. Example of Measurement Value of CSV Output (Original Wavelength Pitch):
Common for WSDac700N and WSDisp700N

N

Measured Date
Data 2015/11/27 2015/11/27 2015/11/27 -
Time 11:07:00 11:08:00 11:09:00 g<|| Measured Time
Memo EKO WISER EKO WISER EKO WISER QN
\| Data Memo
Sensor MS-700N MS-700N MS-700N \\‘
Exposure 50 50 50 ﬁ Instrument
Time(msec) \ﬁl
Sensor 24.8 24.7 24.7 Exposure Time
e
Temp.(deg) "\l Inside Temperature
Power[V] 5.9 5.9 5.9 \‘\.
Wavelength Irradiance Irradiance Irradiance \I Applied Voltage
(nm) (W/m?um) (W/m?um) (W/m%um)
289.16 0 0 0
340.08 0 0 0
343.07 288.25 285.05 291.44
346.05 /\  291.09 288.87 292.14
| — ) W—
Measured MS-700N
Wavelengths Radiation Data
alle O

The calculated value of CSV data file can be saved with data such as PAR (Photosynthetically Active
Radiation), PPFD (Photosynthetic Photon Flux Density), ILLUMINANCE, Integral (interval integrated value)

that are calculated out from the data in each calculated intervals.

The PAR/PPFD are calculated from the

data between 400~700nm and llluminance is calculated by multiplying the standard relative luminosity curve

to the data between 380 and 780nm.

specified wavelength interval.

with 1nm pitch.

Table 6-3. Example of Calculated Value CSV Output, only WSDisp700N

2015/11/27
Time PAR(W/m?) | PPFD(umol/m%s) | ILLUMINANCE(IX) | Integral[350-1050](W/m?)
11:07:00 | 250.56 1149.4 63839.3 138.2
11:08:00 | 250 1147 63740.3 139.5
ilﬁ)po 250.98 1151. 639925 131.7 _'\\
L N ) SN——
Measured PAR PPFD ILLUMINANCE Radiation Integrated
Date & Time Data Data Data Data

Integral (interval integrated value) will be the integrated value in the

Either one will be the calculation result of data which was linearly interpolated
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7. Measurement Software (WSDac700N)

WSDac700N_1xxx.exe is measurement software, and it has main function of data measurement, including the
scheduled measurement.

Scheduled measurement takes measurement automatically repeated daily at a certain time frame and in time
interval which are setup in advance then save the data in WSD file. In each data measurement, the most

appropriate exposure time is automatically setup by the software and takes and save the spectrum data.

NOTE: When taking measurements by switching multiple units of MS-700N on one computer, make sure
to do the following:

- Restart the software each time the instrument is switched. If the software is not restarted, the

calibration value saved from the previous measurements will be used, and the measurement will not

be accurate.

- Change the folder for saving. With this software, the multiple data of the same model type
instrument cannot be saved in a same folder.

7-1. Starting Measurement Software WSDac700N
As the “WSDac700N_1xxx.exe” is started, the Fig.7-1 Window is displayed.

’ 51 WSDac EI@

File Measure View Help

B BB S T

Iredimn ca W md Fumd

Yermhngth [nm)

Ready UM

Figure 7-1. WSDac700N_1xxx.exe Main Window
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7-2. Before Starting Measurement

Before starting the measurement, setup the measurement condition.

Go to [Measure > Measurement

Settings] from the menu bar or click the [Configuration] icon located at the top (Figure 7-2) then the

[Measurement Settings] window will be displayed as shown on Figure 7-3.

51 WsDac
f .
Configuration File Measure View Help
Button g
Brd BB & 7
Figure 7-2. Configuration Button
Measurernent Settings

—COM Port

User Comment

L MS-700N
COM Port -

Setup

Measurement

Time Setup

=~

| EKO MS-TOOM

J User Comment

Integration Range(nm})

From I 330

Integration

Range Setup

StﬂrtlEi jl: ID jl Finishlzuﬁ: ID ;| Every 10 ;| minutes

|: Measurement Time
\
r

Save Folder for

Binary Format

WSD Format data

File Name: ™™™ MMDD. w=d™ (Daity)

CAEKOAM S-7O0MY

Browse |

Save Checkbox

1/— 7/

—

Wavelength
Interval to be
saved in CSV

Auto-Start After I\
Software

Starting

Checkbox

CSV Format data Wavelength
[¥ Save - File Name: ™Y MMDDhh.cev” (Hourhy)
Range to be
Wavelength Interval Wawvelength Rangeinm} / L— saved in
s
Raw = 1nm Erom | 350 To I 1050 | CSV Format
I SR Browse | Folder Location
for saving CSV
Format Data
N\ — Auto-Start after oK Cancel |
' Spftware Starting

Figure 7-3. Measurement Setup Window
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Table 7-1. Measurement Setup Window Functions

Functions

[COM Port Setup]

Description

Select a COM Port which is connected to the instrument to be controlled.

[User Comment]

Save the measurement data with attached memo which is entered in this box.

[Integration Range]

Indicates the specified integration value interval on the measurement data graph
window.

[Measurement Time]

Measurement will be taken in the specified interval during the measurement start
time to the end time.

[WSD Format Data]

A folder can be selected to save the Binary format spectrum data. Click [Browse]
button to select a folder for data to be saved. When the data is taken, the file
name will be saved with the measured date [YYYYMMDD.WSD] (YYYY: Year, MM:
Month, and DD: Day)

[CSV Format Data]

A folder can be selected to save the CSV format spectrum data.

[Save] Checkbox

By checking this checkbox, measurement data in each time interval are saved in
CSV format file. The file name will be the date and time of the measurement, such
as [YYYYMMDDhh.WSD] (YYYY: Year, MM: Month, DD: Day, and hh: Time).

Wavelength Interval

By selecting the “Raw”, the data is saved with the unique wavelength interval of the
instrument itself. By selecting “Inm”, the data is saved as linearly interpolated in
1nm interval.

Wavelength Range

The data will be saved in CSV format data in the wavelength range which is
specified; this is effective only when the Wavelength Pitch is setup with “1nm”.

Folder for Saving
CSV Format Data

Click [Browse] button to specify the folder for data to be saved. For CSV format file
will create a Year folder [YYYY] automatically under the specified folder to save the
data.

[Auto-Start After Software
Starting]

By checking the checkbox, the measurement will be automatically started as the
software is started up with the condition setup in the last measurement condition.
When clicking [OK] button shown at the bottom of the window, the data save folder
setup is completed.
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7-3. Start Measurement

There are Manual Measurement, which takes just one measurement, and Interval Measurement, which takes
measurement by specified interval.

To start a manual measurement, go to [Measure - Start Manual Measurement] from the menu bar or click
the [Manual Measurement Start] button located at the top (Figure 7-4); the [Manual Measurement Running]
window is displayed as shown on the Figure 7-5.

To start Interval Measurement, go to [Measure - Start Interval Measurement] from the menu bar or click the
[Start] button (Figure 7-6) located at the top; the [Interval Measurement] window is displayed as sown on

Figure 7-7.

71 WSDac
File Measure View Help

h BB S 7

Figure 7-4. Start Button

Manual Measurement
Start Button

o "

Manual Measurerment

Current Time

][

Measurement Button

— Abo ﬁ Terminate Manual

1| MS-700N Measuring
—
Instrument Status I—

Figure 7-5. Manual Measurement Window

] WSDac
Interval Measurement File Measure View Help
Start Button *:B‘ EI % ?

Figure 7-6. Start Button

- "

Interval Measurement

Current Time N | I
~2015/M12M14 08:39:05 Abo Terminate Interval

1 Measurement Button

MS-r00M READY
——

Instrument Status

A\ ]/ —

Figure 7-7. Interval Measurement Window

[Current Time]: The current time is displayed.
[Instrument Status]: The status of the measuring instrument is displayed. The Table 7-2 describes the
meaning of each message and status, and how to deal with the statuses.

[Abort] Button: Terminates the manual or interval measurement.
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Table 7-2. Messages Displayed on the Interval Measurement Dialog Window

Messages

Error (Opening COM Port failed)

| Statuses

Cannot open the setup
communication port.

Actions ‘

Check the measurement settings.

Getting the sensor information

Software retrieving the sensor
information. Normal condition

No action necessary

Error (Communication with the
sensor failed)

No responses from the instrument

Check the communication cable
and power supply of the instrument.

Error (Getting the sensor
information failed)

Error (Getting the calibration value
failed)

The communication is unstable.

Check the communication cable for
disconnection and cable condition.

Error (Sensor Name)

A sensor which is different from the
setup is connected.

Check the communication port and
the corresponding instrument.

READY

Completed the measurement
preparation.

No action necessary.

Measuring

Displayed during the measurement
is taken.

No action necessary.

Retrying measurement

The measurement failed, but
retrying to start measurement.

Measurement failed

Displayed when the measurement
is retried for 3 times and
measurement failed.

Check communication cable and
power supply of the instrument.

Measurement OK

Measurement was done

successfully.

No action necessary.

Application Log File (YYYY(Year).LOG)

The YYYY(Year).LOG file will be created in the same folder where the WSD file, which saving file location

was setup for the WSDac Measurement Software, is saved.

This file records the information such as application start-up, measurement start, measurement error, file

processing error. (Table 7-3)

Table 7-3. Contents Indicated in Application Log File

Message ‘ Condition ‘
APP START Measurement Software startup
APP CLOSE Measurement Software shutdown

INT.MEAS START

Started Interval Measurement

INT.MEAS STOP

Ended Interval Measurement

ERROR MEAS THREAD CREATE

Internal Error (Measurement Thread startup failed)

ERROR WSD LOAD

Existing WSD file uploading for adding data failed

ERROR MS700N MEAS

MS700N Measurement failed.

ERROR WSD SAVE

WSD File Saving failed.

ERROR CSV SAVE

CSV File Saving failed.
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7-4. Measurement Data Display

By taking a measurement, the Measurement Data display window shows the graph (Fig. 7-8).

updated per each measurement.

p

This graph is

5] WSDac |:|||IEI||EI§|1
File Measure View H
_ - User Comment Range of Instrument
A g . Integration Value .
\~ Information
Measured Date & Time Bl MI-TOON N\ ﬁ
\lml&"H&? 11:0m00 Irtagral | b 197t e — Tosivem)
— M- —
Expoaira e Ss
Harmor Tamp. | d Sday
10000 Hupply volb D5
000 f/L Jv\\
T
B \N\’\
E BOOG |n\ \/\\V\
Bl \I v
I ! V ’
0
[L15]
Eh) a0 B0 i) a0 00 000
Waea argth (hn]
Ready MUM

[Measured Date & Time]:

[User Comment]:

[Range of Integration

Value]:

[Instrument Information]:

Figure 7-8. Measurement Data Display Window

The date and time of the displayed measurement taken.

Displays the [User Comment] entered in the Measurement Setting.

Displays the spectrum radiation integration value (W/m?) within the wavelength

range which is setup in [Integration Range] in the Measurement Setting.

Displays the information of [Buildup Time (Exposure Time)], [Sensor Temperature],

[Power Supply Voltage]
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7-5. Graph Setting

When specifying the graph axis and color of line on the displayed graph, use the [Graph] button. Either go
to [View > Graph Settings] from the tool bar or click the [Graph] button (Figure 7-9) located at the top, the

[Graph Settings] window will display as sown on Figure 7-10.

71 WSDac
File Measure View Help

T E B & 7

Figure 7-9. Graph Button

Graph Button

-

Graph Settings @
L -Axis
Y-Axis Setting Graph Color
F
v Auto | 100
Wim2ium
- J Graph Color
L X-Axis{n] Frame Color < Frame Color
~Axis[nm L
. . Grid Line
X-Axis Setting
From | - T|:|| - [+ Grid Line
OK | Apply Cancel |
Figure 7-10. Graph Settings Window
[Y-Axis Setting]: By checking the “Auto” checkbox, the Y-Axis scale is automatically setup. By
removing check from the “Auto” checkbox, the maximum value of Y-Axis can be
specified
[X-Axis Setting]: Specify the X-Axis wavelength range to be displayed on graph.
[Graph Color, Frame By clicking the colored area, the color selection dialog window will be displayed,
Color, and Grid Line]: and the graph and frame color can be specified as desired. The grid line of the
graph can be shown or not shown by checking or un-checking the [Grid Line]
checkbox.
[OK, Apply, Cancel] By clicking the [OK] button, the Graph Setting window will disappear and go back
Buttons: to the graph display window.

Clicking [Apply] button will allow the user to see the changes on the graph with the
Graph Setting window still opened.

[Cancel] button can cancel the setting changes on the Graph Setting.
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7-6. Graph Copy

This function copies the graph image displayed on the window on to clip board. Go to [View - Copy] from

the tool bar or click the [Copy] button (Figure 7-11) at the top to make copy of the graph.

QWSDEC
File Measure View Help

B & %

Figure 7-11. Copy Button

Copy Button

7-7. Print

This function prints the graph image displayed on the window. Go to [File = Print] from the tool bar or click
the [Print] button (Figure 7-12) at the top to print the graph.

21 WSDac
File Measure View Help Print Button

B ER S

Figure 7-12. Print Button

Also, to see the print preview condition, go to [File = Print Preview] from the tool bar. Printer can be setup
from [File - Printer Setup] on the tool bar.

7-8. Version Information

The software version information can be displayed. Go to [Help > About WSDac700N...] from the tool bar

or click the [?] button (Figure 7-13) at the top to see the software version information.

£ WsDac About Button
File Measure View Help

h@%%‘ﬁ’/

Figure 7-13. About Button
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8. Data Analysis Software (WSDisp700N)

WSDisp700N_V1xxx.exe is data analysis software, and it has main function to view the measured data (WSD) and

save as CSV format files.

8-1. Starting Data Analysis Software WSDisp700N
As the “WSDisp700N_1xxx.exe” is started, the Figure 8-1 Window is displayed.

S == E=m |
File View Help

THEEEEEE L IELREE

Ready | num|

Figure 8-1. WSDisp_V1xxx.exe Window

8-2. Display Measurement Data

1. Data Uploading
Open the saved measurement data.  To open, go to [File = Open...] from the tool bar or click the [Open]
button located at the top of the window (Fig. 8-2). When the file selecting dialog window appears, select a

measurement data file (extension: WSD file) and click [Open] button to show the data.

Open File VWiew Help
P T B RE EE e RR(E]?

Figure 8-2. Open Button for Measurement Data Files
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2. Displaying Data

List

After the measurement data is uploaded, “Tiled Data Window” appears as shown on Figure 8-3.

Only on this window, the data can be deleted by selecting data, then right click - Delete.

(5 WSDisp - [20151127.WSD] [E=H EeE =
File(F) Edit(E) View(¥] Window(W) Help = ||| =
FEHB BB R ?
e, [ PP, L, I
i = p W) Al N rl =
=110 [ ™ - ™
[ TIVIOT TV ' 1 TV |E
TG/ 11737 10700 TG/ 11727 TR0%00 OB/ 11727 T80 TG/ 11737 TT1600
[, £ P, el
i T i e A A al e
iy = T =y
[ I U" i T ].f‘ a ¥ T V
TG/ 11737 TT1T00 TG/ 11727 L1200 611727 TT.1500 TG/ 11737 111800
ol M i [
Wi, ol Ty ol Ty ol “Wm
=0 =1 P =
i wals 7T P I Vg
016711737 11160 016711727 113600 0611727 114700 016711737 113800 -
NUM

Figure 8-3. Tiled Data Window
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3. Viewing Data Details

Double click the data shown on the Tiled Data window, or go to [View - Selected Data] on the tool bar, or

clicking the [Selected Data] button (Figure 8-4) will display the “Tiled Data window” as shown on Figure 8-5.

[

Button

Selected Data

Disp - [20151127.WSD]

Figure 8-4. Selected Data Button

W

Previous/Next Data Button

-

Range of

]

File(F) Edit(E) View

@\WﬁHem
BB I |8

= R =R

User Comment

Integration
Value

J L

g X

Instrument

Measured

Date & Time '\
2015 MAET 110800

Information

7

ERD MS—?O%

/

[Pl @ e Wm0 — 10n0vm)

000

— 5=l —
Exposura e : S0ms
Savaor Temp. : 2 0uay
Supply violk ;S

AN

A0

[

Tiled Data Button

N

0.0

p

T

trradarca mZam]

B

Hal

it}

Ready

Wil argth ]

MU

[Previous/Next Data]:

[Tile Datal:

[Measured Date & Time]:

[User Comment]:

[Range of Integration

Value]:

[Instrument Information]:

Figure 8-5. Measured Data Details Window

By clicking these buttons, the data previous or next to the data currently shown is
displayed. Arrow keys (&/-) on the keyboard can be also used to for this
function.

The display window can be switched back to the Tiled Data window by clicking this
button. Double clicking the displayed graph can also switch to the Tiled Data
window.

The date and time of the displayed measurement taken.

Displays the [User Comment] entered in the Measurement Setting.

Displays the spectrum intensity integration value (\N/mz) within the wavelength
range which is setup in [Integration Range] in the Measurement Setting.

Displays the information of [Buildup Time (Exposure Time)], [Sensor Temperature],
[Power Supply Voltage]
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4. Displaying Specific Wavelength Data

Left clicking the mouse on the graph displayed on the graph displaying window, a cross-cursor appears as
shown on Figure 8-6, and the value of the point where cross-cursor intersection is located is displayed on the
right bottom of the graph. The cross-cursor moves as left clicking and moving the mouse; the values of each

intersection position are shown at the right bottom of the graph.

[ WsDisp - [20151127.WSD] =N e

D File(F) EditE) View(V) Window(W) Help NE
=EB ] &= = =
EKD MS-TO0M 3

HAR1AET 110700 A0 — 1080k )
Cross Cursor Expoi i S
Sargor Tamp. 1 B 0oay
oo 7/ Supply volt © 55y
i /\/L [\ /
T
B \N\’\
% BO00, In‘-
B N \I M Wavelength and Irradiance
wos j‘w U h\"\’/ Values are displayed.
200,
[v1i)
400 B m S 1
—
Ready MNUM

Figure 8-6. Displaying Specific Value on Graph

5. Displaying Multiple Selected Data
When selecting multiple data in a sequential range, first left click the first data in the range then as pressing
the [Shift] key, click the last data in the range. The data can be selected as shown on the Figure 8-7.

Also by using [Ctrl] key, the desired multiple data can be selected.

[ WSDisp - [20151127.WSD] o=@ 2]
File(F) Edit(E) View(V) Window(W) Help N EE
=B | = ?

e bl e Faiay i Fa iy I i
7 ™ W L™ 7 i B = = by 2 R, B e W %
I ™~ T [ ™= = |l =
" ] |l 5 T ] ¥ ¥ |7

O
[l T T |
ol [ ]

Figure 8-7. Selecting Multiple Data
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As the multiple data are selected, right click the mouse and select [Spectral Data] from the dropdown list.

The data are displayed in superimposed condition as shown on Figure 8-8.

(&P WSDisp - [20151127.WSD] [E=0|E=R ()
File(F) Edit() View(V) Window(W) Help REIF
=3 I = & 7
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f )\%"*‘ﬁ).
ao0 i Paa
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E ¥ | Loy
g B0, Y \’\f\f_‘lu_q' ﬁgﬂi
E -\\’%\;’%
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iy
400 ) b SO0 1
Waval arath (ren)
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Figure 8-8. Superimposed Graph for Displaying Multiple Data

There are 10 colors for graphing: Red, Orange, Yellow, Yellow Green, Green, Light Green, Light Blue, Blue,
Navy and Purple, registered as default colors. If more than 10 data are selected, the colors are repeated.
Graph colors can be freely changed by opening the WSDisp700N_V1xxx.ini file as text editor and editing
each RGB values of the [COLOR TABLE]. Also by adding the number of lines, more than 10 colors can be

registered.

WSDisp_V1xxx.ini File

[COLOR_TABLE]
#LINE_COLORO001=R,G,B
LINE_COLOR001=255,0,0
LINE_COLOR002=255,94,25
LINE_COLOR003=251,236,53
LINE_COLOR004=128,255,0
LINE_COLOR005=0,255,0
LINE_COLOR006=0,255,128
LINE_COLOR007=0,255,255
LINE_COLOR008=0,128,255
LINE_COLOR009=0,0,255
LINE_COLOR010=128,0,255
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6. Deleting Data

The data can be deleted on the tiled data list window by selecting data - right click = delete.

However, the data will not be completely deleted from the WSD file just by this procedure. In order to delete
the original data, it is required to select “Save” from the File menu. Note that the original data will not
recover by overwriting the file to save. If the original data is an important data, it is recommended to select

“Save as...” to save with different name.

8-3. Data Setting

In order to setup the range or pitch of wavelength for saving data in CSV format, contents of the data to be
saved, or setup the integration range, click the [Data Settings] button. Go to [File > CSV Settings] from
the tool bar or click the [Start] button (Figure 8-9) located at the top then the [CSV Settings] window is

displayed as sown on Figure 8-10.

Dat; Settings (] WSDisp - [20151127.WSD]
utton
it(E}  View(V) Window(W)] Help
= EH B [ E &> =
Figure 8-9. Data Setting Button
CSV Settings
“Wigvelength Interval Wiavelength Range(nm) CSV Wavelength
CSV Data L Range
Waveform (7&“ Fawy " 1nm | BT 1o | 1050 4—1
L ~Integration Range(nm)
Integration Range ~—_
Setting con (350 o [1080 oK Cancel |
Figure 8-10. CSV Settings Dialog Window
[CSV Data Waveform]: Specify the wavelength pitch for when the [Saving Measurement Value in CSV

Format]. By selecting the “Raw”, the data is saved with the unique wavelength
pitch of the instrument itself. By selecting “Inm”, the data is saved as linearly
interpolated in 1nm pitch.

[CSV Wavelength Range Specify the wavelength range for [Saving Measurement Value in CSV Format]; this

(nm)]: is effective only when the Wavelength Pitch is setup with “1nm”.

[Integration Range]: Specify the integration range for [Saving Measurement Value in CSV Format].
Also display the specified range of integrated value on the Selected Data display
window, and the range becomes the integrated value of the saving CSV calculated
value.
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8-4. Graph Setting

When specifying the graph axis and color of line on the displayed graph, click the [Graph] button. Go to

[View = Graph Settings] from the tool bar or click the [Graph] button (Figure 8-11) located at the top then the

[Graph Settings] window will display as sown on Figure 8-12.

[ (K7 WSDisp - [20151127.WSD]

Graph Button

Edit(E) View(V) Window(W) Help
& B ¢ D =

Figure 8-11. Graph Button

Y-Axis Setting I_

=]

X-Axis Setting

Graph Settings @

Graph Color Graph Color

—=f AUTO [100 Wim2ium - J Frame Color
<j

c, c
%r 350 | g | 1050 [7 Grid Line

-

-Axis

Grid Line

Frame Color

K-Axizinm)

Tile Size

/J Tiled Data Display

Size Setting

{ 40x30  B0x60 i+ 160x12  240x18

OK Apphy Cancel

[Y-Axis Setting]:

[X-Axis Setting]:

[Graph Color, Frame
Color, and Grid Line]:

[Tiled Data Display Size
Setting]:
[OK, Apply, Cancel]

Buttons:

Figure. 8-12. Graph Settings Window

By checking the “Auto” checkbox, the Y-Axis scale is automatically setup. By
removing check from the “Auto” checkbox, the maximum value of Y-Axis can be
specified

Specify the X-Axis wavelength range to be displayed on graph.

By clicking the colored area, the color selection dialog window will be displayed,
and the graph and frame color can be specified as desired. The grid line of the
graph can be shown or not shown by checking or un-checking the [Grid Line]
checkbox.

Setup the size of the one measurement data to be displayed on the Tiled Data
display window.

By clicking the [OK] button, the Graph Setting window will disappear and go back
to the graph display window.

Clicking [Apply] button will allow the user to see the changes on the graph with the

Graph Setting window still opened.

[Cancel] button can cancel the setting changes on the Graph Setting.
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8-5. Data Saving

To save one or more measure

ata or calculated data in CSV

format, either go to [File] (Figu’e@ﬂ?%molwéblﬂwﬁﬁé [Save] button at the top (Figure 8-14).

[Save]:
[Save As...]:

[Save Measured Value as
CSV Format]:

[Save Calculated Value
as CSV Format]:

Save As..
Save Measured
Data Save as CSV(Spectral Data)

Edit() View(V) Window(W) Help

Open... Ctrl+O

Close

Save Ctrl+5

Save as C5V(Calculated Data)
CSV Settings

Print Preview
Print... Ctrl+P

Printer Settings...
Recent Files

Exit

Figure 8-13. Data Saving from Menu bar

Save the measured data (WSD Format) with same name as the original file name.
Save the measured data (WSD Format) with different name as the original file.

Save the measured time, comment, data comment, sensor type, exposure time,
applied voltage on sensor, and spectrum data per specified wavelength pitch of the
selected measurement data in CSV format.

Save the data of PAR (W/m?), PPFD (umol/m?%s), ILLUMINANCE (Ix), and integral
(\N/m2) per each measured time of the selected measurement data in CSV format,

Overwrite Button for
Measured Data (WSD
Format)

r (=] WSDisp - [20151127.
File(F) Edit(E
"=

Save Button for
Measured Value in
CSV Format lp

= &

[Overwrite Button for

Measured Data]:

[Save Measured Value as

CSV Format]:

NOTE:

opened, depending on the spreadsheet software type.

Figure 8-14. Save from the Icons

Save the measurement data (WSD format file) with same name as the original file
name.

Save the measured time, comment, data comment, sensor type, exposure time,
applied voltage on sensor, and spectrum data per specified wavelength pitch of the

selected measurement data in CSV format.

If the CSV converted data is lined more than 256, error message may appear when the file is

If such error message appears, convert into CSV

when there are less than 256 data lines.
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8-6. Graph Copy

The image of the displayed graph can be copied on the clipboard. Go to [View - Copy] from the toolbar or
click the [Copy] button (Fig. 8-15) at the top.

(&P WSDisp - [20151127.WSD]
File(F) Edit() View(V) Window(W) Help
= EH B & B ¢ = =R

Figure 8-15. Copy Button

Copy Button

8-7. Print

This function prints the graph image displayed on the window. Go to [File - Print] from the tool bar or click
the [Print] button (Fig. 8-16) at the top to print the graph.

[@ WSDisp - [20151127. W50 Print Button

[ File(F) Edit[) View(V) Window(W) Help
= EHB & B ¢ o = ?

Figure 8-16. Print Button

Also, to see the print preview condition, go to [File = Print Preview] from the tool bar. Printer can be setup

from [File - Printer Setup] on the tool bar.

8-8. Version Information

The software version information can be displayed. Go to [Help = About WSDisp700N...] from the tool bar

or click the [?] button (Fig. 8-17) at the top to see the software version information.

i} WSDisp - [20151127.WSD] About Button
File(F) Edit() View(V) Window(W) Help
FEHBE BB E e & %

Figure 8-17. About Button
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Measurement Principle

9-1. Measurement Principle

Block diagram of the Spectroradiometers MS-700N is as follows:

Sensor Head

L1\ Power Supply . pC

| | Sensor Cable RS232C
| | RS422 WO FoweR supLY "o Cable

w700/ 701)

10m — 1.5m

*PC is not included in the package

Figure 9-1. Block diagram

MS-700N sensor part consist of components, such as a dome, a diffuser, a shutter to measure the dark
current, a grating with diode array to disperse the light, Peltier element to control temperature, and print circuit

board. (See below diagram)

Dome

Diffuser

Shutter

—w
%ating Photadiode

Spectro‘w array

L = Control
— Power PC
— Unit

/ | 555 | Supply

Fiber

Peltier element

Figure 9-2. The sensor head configuration
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10. Maintenance & Troubleshooting

10-1. Maintenance

To maintain accurate measurement, it is recommended to check and do the following:

Table 10-1. Maintenance

Maintenance Item ’ Frequency |

How To

Remove soil from the quartz
dome with air blower or soft cloth

and alcohol.

Effect

Transmittance will change and
sensitivity decreases when the

quartz dome is soiled.

Check for any crack or scratches

on the glass dome.

May lead to water leakage inside
the sensor and cause damages to

the sensor.

Adjust the spirit level on the
sensor to keep it in horizontal

position.

If the sensor level is not in
horizontal position,
measurements will be in accurate
by affecting on cosine/azimuth

response.

Check the condition of sensor

and communication  cables,
making sure they are connected
properly, and they do not have

any excess tensions

A disconnected cable may cause
abnormal measurement values
and operation mistakes.
Damaged cables may also have

risks of noise or electric shock.

Make sure the sensor is securely

fixed on the mounting base.

Sensor may drop and cause

damages and/or injury.

Check the color of the silica gel.
If the silica gel color changes
from blue to pink, replace them.
in

Turn the drying cartridge

anti-clockwise to remove.
Replace with new silica gel on a

clear day with less humidity.

Moisture gets inside the sensor
while it is sued for a long period of
time. Moisture saturated silica
gel will lead to condensation and
may cause decrease of output

and damage.

Clean Quartz Dome Several
times per

week

Check Glass Dome Weekly

Condition

Check Sensor Weekly

Horizontal Position

Check Cable Weekly

Condition

Check Sensor Weekly

Fixing

Check Silica Gel Weekly

and Replace

Recalibration Every 2
years

To maintain the best possible
measurement accuracy, it is
recommended to recalibrate the
sensor every 2 years.

Contact EKO for more details and
requests for a recalibration and

maintenance service.

Sensitivity of the sensor changes
by aging and may lead to taking

inaccurate measurements.
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10-2. Calibration Method

It is recommended to recalibrate the instrument once every 1~2 years. For further information about the

calibration and recalibration, please contact EKO.

The spectroradiometer is calibrated against a NIST (National Institute of Standards and Technology)
traceable tungsten-halogen OL-FEL standard lamp at a distance of 50 cm. The standard lamp has a known
spectrum and the absolute irradiance is calibrated at several wavelengths. By measuring the
spectroradiometer's detector responsivity in counts as a function of the irradiance at corresponding
wavelengths, the sensitivity of each photo diode array pixel is converted into absolute units (W/mzlum).

The calibration function is determined by averaging 10 single measurements, measured separately for
several different wavelength intervals each with a fixed exposure time. This is to use optimal output
characteristics of the detector. Finally the calibration function is uploaded to the spectroradiometer firmware

for automatic conversion of measured count into absolute units.

The spectroradiometer is provided with a calibration certificate indicating the measurement uncertainty. The
combined uncertainty of the calibration function for each wavelength interval is based on individual uncertainties

contributed by the standard lamp, calibration set-up and spectroradiometer performance properties.

10-3. Troubleshooting

Check the following items in case of trouble with the instrument. If any questions should remain, contact

EKO for further technical support.

Table 10-2. Troubleshooting

Failure ’ Action

- Cannot operate from PC. The cable connections for PC, power supply, and/or sensor part may be

- The data cannot be acquired. | connected incorrectly.

1) Check if the connection between PC and power supply, and power supply
and sensor.

2) Check if the power of PC and power supply is turned on.

3) Check the fuse which is in the fuse box on the power supply rear panel; make
sure it is not blown. If the fuse is blown, replace with the new fuse which is
specified on [Table 11-3. Power Supply Specification].

4) Check if the COM port connected to PC is correct.

5) Reboot the PC and check the communications and see if PC operation
recovers successfully.

6) Remove anything which could cause the noise for power supply cable and
sensor cable.

- The measured value is | 1) Shutter, spectrometer or PCB could be defected. In case there are any
abnormal damages or malfunctions, please call EKO for assistance

- S/N value of acquired data is 2) If multiple MS-700N is connected to one PC to operate, make sure to restart
not good. the software each time the instrument is switched.

- Measured value is very low. Check if the dome is clean. Refer to the chapter “Maintenance”

- The software is operating The PC and software could be defected.
abnormal. Reboot the PC then retry the software.
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11. Specification

11-1. Sensor Specifications

Table 11-1.Sensor Specification

Characteristics

Wavelength

Details

350~1050nm

Wavelength Interval

2.5~3.2nm

Wavelength Resolution

<10nm

Wavelength Accuracy

+0.3nm

Cosine Response
(Zenith: 0~80°)

<7%

Temperature Dependency

<2%

Operating Temperature

Temperature : -10~+50°C

Temperature Control
(Ta: Ambient temperature)

25°C+2°C (Ta = -10 ~ +40°C)
25°C~ 32°C (Ta = +40 ~ +50°C)

Exposure Time

10msec~5,000msec, automatically controlled

Dome Material

Synthetic Quartz

Communication

RS422 (between sensor and power supply unit)

Power Supply

12VDC(from power supply unit)

Maximum Power Consumption

50w

Dimension
(Including cover & dome)

220(()x197(H) mm

Weight (Sensor Part)

4.5kg

Table 11-2. Definitions of Terms

Wavelength Range

Definitions

Range of wavelength which can be measured

Wavelength Interval

Interval of wavelength for measuring data

Wavelength Resolution

Full width at half-maximum when emission line is input

Wavelength Accuracy

Accuracy is the proximity of measurement results to the true wavelength value

Cosine Response

Difference from the theoretical value (cos 6) at zenith angle of 0°~ 80°

Temperature Dependency
-10°C ~ +50°C.

Tolerance of change in output when ambient temperature changes between

) Shutter open time.
Exposure Time

Optimum value is automatically selected in the time

between 10msec ~ 5,000msec.
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11-2. Power Supply Specification

Table 11-3. Power Supply Specification

Details

Input : 100~240V, 50/60Hz

Power suppl
pply Output : 12VDC (50W)

Maximum Power Consumption 100W (when DC output 50W)

$5.2x20, 250V, 2A

Communication RS232C(between power supply and PC)
Operating conditions Temperature: -10 to +40°C, Humidity: 0~90%RH (No condensation.)
Dimension 320(W) x 240(D) x 80(H) mm
1kg
11-3. Software
Table 11-4 Software Specifications
Details

Applicable OS Microsoft Windows XP/Vista/7/8

CPU: Pentium 1GHz or more (recommended)

Memory: More than 1GB (recommended)

HHD Capacity: More than 20GB (recommended)

Operation Environment

More than 1024 x 768 (recommended)
RS-232C port
CD-ROM drive

Display Resolution:
Interface:
Optical Drive:

Data Measurement (Continuous, free exposure time adjustments)
) Data Saving (Personalized format, CSV format)

Software Function . . . . . .

Data Graphing (Tiled/Detailed display, Unit conversion)

Data Calculation (PAR, PPFD, llluminance, Integral)
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11-4. Cables

Table 11-5 Cable Specifications

Cables Details
Cable Type: MVVS
Diameter: 0.5mm? x 12pins
Sensor Cable Outer Diameter: ®10.4mm
Cable end Y Terminal (Model Number)
Cable Length: 10m
Flug
MNJW-2012FF8 Terminals
- Brown 5 n ThD4 1
® I [ TS V4 (Red)
I
@ Red | |i I| li TIJ‘ E :’\g Y { (Blue)
|
© 0fﬂﬂ99| || || BADE 3 2y (red)
FTOR
@ Yellow, | 5 RXD 4 :\’g Y § (Blue)
©) Green ! JGND 5 ”_’E ¥4 (Blue)
® Blue
@ Purplg— ;
® Gran | i | v i ﬂ Y 4 (Red)
@) —whit | | | LIVG | T (C V14 (Blue)
@ Black |I I| | || A W (V4 (Red)
@ L LLIVE 3 2 4 (Blue)
| L -
@ — Black |/ VEARTH 11 ,—/\Fj ¥ ¢ (Blue)

Figure 11-1. Sensor Cable Connections
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11-5. Dimensions

1. Sensor Part

2-10w Fixing Hole

180

Figure 11-2. Sensor Part Dimensions

2. Power Supply

320 240

4

iNEEEEREEERE R

® @
] ®

g 0

Figure 11-3. Power Supply Dimensions
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11-6. Accessories List

Table 11-4. Accessories List

Option Items

REMENS

Sensor Cable

Cable Length: 20m, 30m

STR-21G Single Arm Sun Tracker
STR-22G Double Arm Sun Tracker
STR-32G Heavy Duty Sun Tracker

Mounting Plate for DNI Measurement

Mounting Plate for MS-710/711/700N (Secondary Side)

Collimation Tube

Collimation Tube for MS-710/711/700N

Mounting Plate for Diffuse Measurement

For Diffuse solar radiation measurement
(for MS-710/711/712/700N)

Shading Ball Assembly

11-7. Consumable Items

Table 11-7. Consumable Items List

Parts Name

RENMENS

Silica Gel

Grain size 2.2 ~ ¢ 11

Fuse

$5.2x20, 250V, 2A
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